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Safety warning notice

AWARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
Product Name HP EliteBook 8530p Notebook PC v
HP EliteBook 8530w Mobile Workstation v
Processors Intel® Core™2 Extreme processors
QX9300, Quad Core 2.53-GHz processor 12- v
MB L2 cache, 1066-MHz front side bus (FSB)
X9100, Dual-Core 3.06-GHz processor 6-MB N
L2 cache, 1066-MHz FSB
Intel Core2 Quad processors
Q9100, 2.26-GHz processor 6-MB L2 cache, \
1066-MHz FSB
Q9000, 2.00-GHz processor 6-MB L2 cache, S
1066-MHz FSB
Intel Core2 Duo processors
T9900, 3.06-GHz processor 6-MB L2 cache, v R
1066-MHz FSB
T9800, 2.93-GHz processor 6-MB L2 cache, v v
1066-MHz FSB
T9600, 2.8-GHz processor 6-MB L2 cache, v N
1066-MHz FSB
T9550, 2.66-GHz processor 6-MB L2 cache, v S
1066-MHz FSB
T9400, 2.53-GHz processor 6-MB L2 cache, v R
1066-MHz FSB
P9500, 2.53-GHz processor 3-MB L2 cache, v RN
1066-MHz FSB
P8800, 2.66-GHz processor 3-MB L2 cache, v N
1066-MHz FSB
P8700, 2.53-GHz processor 3-MB L2 cache, v S
1066-MHz FSB
P8600, 2.4-GHz processor 3-MB L2 cache, v R

1066-MHz FSB
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Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
P8400, 2.26-GHz processor 3-MB L2 cache, N N
1066-MHz FSB
Chipset Intel PM45 Express Chipset with iAMT 4.0 \/ v
support
Southbridge Intel ICH9M-enhanced \/ N
Graphics ATI M86M ATI Mobility Radeon HD 3650 \
graphics card with 256 MB of graphics
subsystem memory (supports Hypermemory)
ATI M86M ATI Mobility FireGL V5700 graphics v
card with 256 MB of graphics subsystem
memory (supports Hypermemory)
nVidia NB9P-GLM2 graphics card with 512 MB N
of graphics subsystem memory (supports
Quadro FX 770M)
HDMI 1.3 compliance N v
OpenGL driver support v
Panel All display assemblies include 3 wireless local N
area network (WLAN) antennas
15.4-in WUXGA AntiGlare with webcam \ v
15.4-in WSXGA+ AntiGlare with webcam V v
15.4-in WXGA AntiGlare with webcam V v
15.4-in WUXGA AntiGlare with 2 wireless wide v
area network (WWAN) antennas
15.4-in WSXGA+ AntiGlare with 2 WWAN \ v
antennas
15.4-in WXGA AntiGlare with 2 WWAN V x/
antennas
15.4-in WUXGA AntiGlare J 3
15.4-in WSXGA+ AntiGlare V 3
15.4-in WXGA AntiGlare J 3
15.4-in WUXGA AntiGlare for computers with N
Extreme and Quad CPUs
15.4-in WSXGA+ AntiGlare for computers with N
Extreme and Quad CPUs
15.4-in WXGA AntiGlare for computers with v
Extreme and Quad CPUs
15.4-in WUXGA AntiGlare with webcam for N
computers with Extreme and Quad CPUs
15.4-in WXGA AntiGlare with webcam for N

computers with Extreme and Quad CPUs
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Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
15.4-in WXGA AntiGlare with webcam for \
computers with Extreme and Quad CPUs
Support privacy filter v R
Memory Two customer-accessible/upgradable memory S
module slots
Supports dual-channel memory v R
Supports up to 8 GB of system RAM v R
PC2-6400, 800-MHz, DDR2 v R
Supports the following configurations: v \
e 8192 (4096 x 2, dual-channel) (select
models)
e 6144 (4906 + 2048)
e 5120 (4096 + 1024)
e 4096 (2048 x 2, dual-channel)
e 4096 (4096 x1)
e 3072 (2048 + 1024)
e 2048 (1024 x 2, dual-channel)
e 2048 (2048 x 1)
e 1024 (1024 x 1)
Hard drives Supports 9.5-mm, 6.35-cm (2.50-in) hard v \
drives
Customer-accessible v \
Serial ATA v \
Supports the following drives: v R
e 500-GB, 7200- and 5400-rpm
e  320-GB, 7200-rpm
e  250-GB, 7200- and 5400-rpm
e  160-GB, 7200- and 5400-rpm
e  120-GB, 5400-rpm
Supports the following solid-state drives: v R
e 128-GB
e 80-GB
HP 3D DriveGuard v J
RAID 0/1 Support v \
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Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
Upgrade bay Fixed (removal of 1 screw required) \/ v
Customer-accessible J y
Serial ATA J v
12.7-mm tray load \/ N
Supports the following drives: N N
e DVDzRW and CD-RW Super Multi DL
Combo Drive with LightScribe
e  Blu-ray Disc ROM with SuperMulti DVD+/-
R/RW DL Drive
e DVD-ROM Drive
Diskette drive Supports external USB diskette drive only \/ N
Supports boot from external USB diskette drive v N
Microphone Integrated dual-array microphone \/ N
Audio HD audio - ADI 1984A J v
Webcam Integrated 2.1-megpixel webcam with business v
card reader support
Modem 56K V.92 1.5-in data/fax modem with digital J v
line guard
HD audio interface J y
Ethernet Intel 10/100/1000 network interface card (NIC) N
with IAMT
S4/S5 wake on LAN: DC - no \/ V
S4/S5 wake on LAN: AC - yes N N
NIC power down technology \/ N
Wireless Integrated WLAN options by way of wireless module:
Three WLAN antennas built into display S N
assembly
Support for no WLAN option N N
Support for the following WLAN formats: \/ N
e Intel 802.11a/b/g/n
e Intel 802.11a/b/g
e Intel 802.11a/b/g/n with iIAMT 4.0 support
e Intel 802.11a/b/g with iIAMT support
Integrated WWAN options by way of wireless module:
Two WWAN 5-band antennas built into display N

assembly
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Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
Subscriber identity module (SIM) security v S
(customer-accessible in battery bay)
Support for the following WWAN formats: v <

e  Evolution-data optimized (EVDO)

° High-speed downlink packet access
(HSDPA)

Integrated personal area network (PAN) options by way of Bluetooth® module:

Support for no PAN option

\/

\/

Broadcom Bluetooth

External media card

One ExpressCard/54 slot

<

Integrated Media Card Reader with SD, MMC,
MS, MSpro, xD, Memory Stick Duo support

< | 2| <

<

Ports

Audio-in (stereo microphone)

Audio-out (stereo headphone)

HDMI

RJ-11 (modem)

RJ-45 (Ethernet, includes link and activity
lights)

< | 2| 2| 2| <

< | 2| 2| 2| <

USB 2.0 (4)

2

<

eSATA/USB 2.0 combo (1)

VGA (Dsub 15-pin) supporting 1600 x 1200
external resolution at 75-GHz (hot plug with
auto-detect)

1394a

3-pin AC power

Docking

HP Docking Station

HP Advanced Docking Station

Keyboard/pointing devices

12.3-in keyboard with durable key cap coating

Dual point (pointing stick and TouchPad) with 3
pointing stick buttons and 3 TouchPad buttons
and vertical scrolling (taps enabled as default)

< | 2| 2| 2| 2| <

< | 2| 2| 2| 2| <

Windows Vista® Hardware Start Button
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Category Description HP EliteBook HP EliteBook
8530p 8530w Mobile
Notebook PC Workstation
Power requirements AC adapter with localized cable plug support N N
(3-wire plug with ground pin, supports 3-pin DC
connector):
° 180-W
° 150-W
° 120-W
8-cell, 2.55-Ah (73-Wh) Li-ion battery \ v
Support for 8-cell Extended Life Battery N N
Support for 12-cell Ultra Capacity Battery \/ N
Security Integrated fingerprint reader \/ \/
Integrated smart card reader \/ v
Security cable slot \/ N
Trusted platform module (TPM) V.1.2 \/ N
Full volume encryption \/ N
Preboot authentication (password, smart card, v
biometric)
Operating system Preinstalled:
Windows 7 Professional 32 \/ N
Windows Vista Business 64 (select regions) N
Windows Vista Business 64 with WWAN v
(select regions)
Windows Vista Business 32 (select regions) \/ N
Windows Vista Business 32 with WWAN J V
(select regions)
Windows Vista Home Basic 32 (select regions) N
Windows Vista Home Basic 32 with WWAN J v
(select regions)
Windows Vista Business with XP Professional v v
image (select regions)
Windows Vista Business with XP Professional v
image with WWAN (select regions)
FreeDOS \/ N
FreeDOS with WWAN J v
Preinstalled with Microsoft® Office:
Windows 7 Professional 32 with Microsoft® \/ v
Office 2007 Personal with Powerpoint
Windows 7 Professional 32 with Microsoft \/ N

Office 2007 Personal

Chapter 1 Product description



Category Description HP EliteBook HP EliteBook

8530p 8530w Mobile
Notebook PC Workstation

Windows 7 Professional 32 with Microsoft v v

Office 2007 Professional

Windows 7 Professional 32 with Microsoft v v

Office 2007 Ready

Windows Vista Ultimate 32 with Office 2007 \ J

Ready (select regions)

Windows Vista Ultimate 32 with Office 2007 \ J

Ready with WWAN (select regions)

Windows Vista Business 64 with Office 2007 S

Ready

Windows Vista Business 64 with Office 2007 v

Ready with WWAN

Windows Vista Business 32 with Office 2007 \ J

Ready

Windows Vista Business 32 with Office 2007 v S

Ready with WWAN

Windows Vista Home Basic 32 with Office v \

2007 Ready

Windows Vista Home Basic 32 with Office RN v

2007 Ready with WWAN

Windows Vista Business with XP Professional \

with Office 2007 Ready

Windows Vista Business with XP Professional S

with Office 2007 Ready with WWAN

Windows Vista Business 32 with Office 2007 v

Professional (Japan only)

Windows Vista Business 32 with Office 2007 v

Professional with WWAN (Japan only)

Windows Vista Business 32 with Office 2007 v

Personal (Japan only)

Windows Vista Business 32 with Office 2007 v

Personal with WWAN (Japan only)

Windows Vista Business 32 with Office 2007 v

Personal with PowerPoint (Japan only)

Windows Vista Business 32 with Office 2007 v

Personal with PowerPoint with WWAN (Japan

only)

Windows Vista Business with XP Professional v S

with Office 2007 Professional (Japan only)

Windows Vista Business with XP Professional S

with Office 2007 Professional with WWAN

(Japan only)

Windows Vista Business with XP Professional N

with Office 2007 Personal (Japan only)




Category Description

HP EliteBook
8530p
Notebook PC

HP EliteBook
8530w Mobile
Workstation

Windows Vista Business with XP Professional
with Office 2007 Personal with WWAN (Japan

only)

\/

\/

Windows Vista Business with XP Professional
with Office 2007 Personal with PowerPoint
(Japan only)

Windows Vista Business with XP Professional
with Office 2007 Personal with PowerPoint with
WWAN (Japan only)

Restore Media:

Windows 7 Professional 32

Windows Vista Ultimate 32

Windows Vista Business 32/64

Windows Vista Home Basic 32

Windows XP Professional

DRDVD Windows 7

DRDVD Windows XP Professional

DRDVD Windows Vista

Office Ready restore DVD

2 | 2| 2| 2| 2| 2| 2| 2| =<

< | 2| 2| 2| 2| 2| 2| 2| <2

Supported:

Windows XP 64 (Service Pack 2)

Certified:

Novell: SUSE Linux Enterprise Desktop

Serviceability End-user replaceable parts:

AC adapter

Battery (system)

Hard drive

Keyboard

Memory module

Optical drive

WLAN module

< | 2| 2| 2| 2| 2| =

< | 2| 2| 2| 2| 2| <
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2 External component identification

Display components

Item Component Function

(1) WWAN antennas (2) (select models only)* Send and receive wireless signals to communicate with
WWANSs.

(2) WLAN antennas (3) (select models only)* Send and receive wireless signals to communicate with
WLANS.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Display components 9



Top components

Pointing devices

Item

Component

Function

(1)

Pointing stick

Moves the pointer and selects or activates items on the
screen.

)

Center pointing stick button

Functions like the center button on an external mouse.

@)

Right pointing stick button

Functions like the right button on an external mouse.

(4)

TouchPad scroll zone

Scrolls up or down.

%)

Right TouchPad button

Functions like the right button on an external mouse.

(6)

Center TouchPad button

Functions like the center button on an external mouse.

@)

Left TouchPad button

Functions like the left button on an external mouse.

()

TouchPad

Moves the pointer and selects or activates items on the
screen.

9)

Left pointing stick button

Functions like the left button on an external mouse.

NOTE: This table describes factory settings. View or change pointing device preferences as follows:

In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.

10 Chapter 2 External component identification



Buttons, switches, and fingerprint reader
OO
) e e

=

Item Component Function

(1) Power button e  When the computer is off, press the button to turn
on the computer.

e  When the computer is on, press the button to shut
down the computer.

e  When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

e  When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about power settings, follow these steps:

° In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

e In Windows XP, select Start > Control Panel >
System and Maintenance > Power Options.

(2) Info button Launches Info Center, which enables you to open various
software solutions.

Top components 11



Item

Component

Function

(3)

Wireless button

Turns the wireless feature on or off, but does not
establish a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(4)

Internal display switch

Turns off the display if the display is closed while the
power is on.

(5

Presentation button

Starts the presentation feature.

(6)

Volume mute button

Mutes and restores speaker sound.

@)

Volume scroll zone

Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume.
You can also press the left side of the volume scroll zone
to decrease volume, or press the right side of the volume
scroll zone to increase volume.

()

HP Fingerprint Sensor (finger print reader)

Allows a fingerprint logon to Windows, instead of a
password logon.

Keys

%NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Function

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) Pointing stick Moves the pointer and selects or activates items on the

screen.
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Item Component Function

(3) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(4) Windows logo key Displays the Windows Start menu.

(5) Pointing stick buttons Function like the buttons on an external mouse

(6) Windows applications key Displays a shortcut menu for items beneath the pointer.

(7) Embedded numeric keypad keys Can be used like the keys on an external numeric
keypad.

(8) Function keys Execute frequently used system functions when pressed

in combination with the fn key.

Lights

® GOOOD

Item Component Function

(1) Wireless lights (2)t e  Turquoise: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Mobile Broadband Module, and/or a Bluetooth
device, is on.

e  Amber: All wireless devices are off.

(2) Power lights (2)* e  On: The computer is on.

e  Blinking: The computer is in the Sleep state
(Windows Vista) or in Standby (Windows XP).

e  Off: The computer is off or in Hibernation.

Top components 13



Item Component Function

(3) Battery light e  Amber: A battery is charging.

e  Blinking turquoise: A battery is close to full charge
capacity.

e  Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

e  Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light e  Blinking turquoise: The hard drive or optical drive is
being accessed.

e  Amber: HP 3D DriveGuard has temporarily parked
the internal hard drive.

(5) Caps lock light On: Caps lock is on.

(6) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.

(7) Volume mute light e  Turquoise: Computer sound is on.

e  Amber: Computer sound is off.

(8) Volume down light Blinking: The volume scroll zone is being used to
decrease speaker volume.

9) Volume up light Blinking: The volume scroll zone is being used to
increase speaker volume.

*The 2 power lights display the same information. The light on the power button is visible only when the computer is open.
The power light on the front of the computer is visible whether the computer is open or closed.

1The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is
open. The wireless light on the front of the computer is visible whether the computer is open or closed.
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Front components

Item Component Function

ireless lig ° urquoise: An integrated wireless device, such as a

1 Wirel light T ise: An int ted wirel devi h
WLAN device, the HP Mobile Broadband Module,
and/or a Bluetooth device, is turned on.

e  Amber: All wireless devices are turned off.

(2) Power light e  On: The computer is on.

° Blinking: The computer is in the Sleep state
(Windows Vista) or in Standby (Windows XP).

e  Off: The computer is off or in Hibernation.

(3) Battery light e  Amber: A battery is charging.

e  Blinking turquoise: A battery is close to full charge
capacity.

e  Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

e  Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light e  Blinking turquoise: The hard drive or optical drive is
being accessed.

e  Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Speakers Produce sound.

(6) Display release latch Opens the computer.

Front components
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Left-side components

500 00

Item Component Function

(1) USB ports (2) Connect optional USB devices.

(2) RJ-45 (network) jack Connects a network cable.

NOTE: The RJ-45 (network) jack provides Gigabit
Ethernet functionality.

(3) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) HDMI port Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

(5) eSATA port Connects an eSATA device.

(6) 1394 port (select models only) Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(7) Media Card Reader Supports the following optional digital card formats:
Memory Stick (MS), Memory Stick Duo (MS Duo),
Memory Stick Pro (MSpro), MultiMedia Card (MMC),
Secure Digital (SD) Memory Card, and xD-Picture Card.

(8) Smart card reader Supports optional smart cards.

9) ExpressCard slot Supports optional ExpressCards.
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Rear components

Item

Component

Function

()

Power connector

Connects an AC adapter.

()

External monitor port

Connects an external VGA monitor or projector.

Right-side components

=

Item

Component

Function

()

Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

()

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

()

USB ports (2) (select models only)

Connect optional USB devices.

(4)

Optical drive

Reads optical discs and, on select models, also writes to
optical discs.

©)

RJ-11 (modem) jack

Connects a modem cable.

(6)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Rear components
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Bottom components

18

Item Component

Function

(1) Battery bay

Holds the battery and a wireless subscriber identity
module (SIM). The SIM slot is located inside the battery
bay.

NOTE: The battery must be installed for the SIM to
operate.

(2) Battery release latch

Release the battery from the battery bay.

3) Docking connector

Connects an optional docking device.

(4) Vents (7)

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(5) Memory module compartment

Contains a memory module slot and an HP Broadband
Module.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical
support through Help and Support.

(6) Hard drive bay

Holds the hard drive.

(7) Business card holder

Holds an optional business card.

(8) Accessory battery connector

Connects an optional accessory battery.
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3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

@ product : oo
- 8/ 2 00000000
B— TR m
e__pfn R akaatatassasasasasasal || {1 {11IEIEL TUTERET TRET IO TARETT HAID
S@rvice | X000 |
i tag | warranty x year : a,

e  Product name (1). This is the product name affixed to the front of the computer.

e  Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

e  Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

° Model description (4). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

e  Warranty Period (5). This number describes the duration (in years) of the warranty period for the
computer.

Service tag 19



Computer major components

Item Description Spare part number

1) Display assembly for use with HP EliteBook 8530p computer models equipped with WLAN and WWAN capability
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)
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Item Description Spare part number
15.4-in, WXGA 495043-001
15.4-in, WSXGA+ 495044-001
15.4-in, WUXGA 495045-001

Display assembly for use with HP EliteBook 8530w computer models equipped with WLAN and WWAN capability
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA 495046-001
15.4-in, WSXGA+ 495047-001
15.4-in, WUXGA 495048-001

Display assembly for use with HP EliteBook 8530p computer models equipped with WLAN and WWAN capability
and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers
and cables)

15.4-in, WXGA with integrated webcam 495049-001
15.4-in, WSXGA+ with integrated webcam 495050-001
15.4-in, WUXGA with integrated webcam 495051-001

Display assembly for use with HP EliteBook 8530w computer models equipped with WLAN and WWAN capability
and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers
and cables)

15.4-in, WXGA with integrated webcam 506809-001
15.4-in, WSXGA+ with integrated webcam 506810-001
15.4-in, WUXGA with integrated webcam 506811-001

Display assembly for use with HP EliteBook 8530w computer models equipped with Intel Core2 Extreme and
Quad processors, and WLAN and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

15.4-in, WXGA 515889-001
15.4-in, WSXGA+ 515890-001
15.4-in, WUXGA 515891-001

Display assembly for use with HP EliteBook 8530w computer models equipped with Intel Core2 Extreme and
Quad processors, WLAN and WWAN capability, and integrated webcam (includes 3 WLAN antenna transceivers
and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA with integrated webcam 515892-001
15.4-in, WSXGA+ with integrated webcam 515893-001
15.4-in, WUXGA with integrated webcam 515894-001

Display internal components:

Display bezel for use with HP EliteBook 8530p computer models equipped with WLAN and  501111-001
WWAN capability

Display bezel for use with HP EliteBook 8530w computer models equipped with WLAN and  506812-001
WWAN capability

Display bezel for use with HP EliteBook 8530p computer models equipped with WLAN and  501112-001
WWAN capability

Computer major components
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Item Description Spare part number

Display bezel for use with HP EliteBook 8530w computer models equipped with WLAN and  506813-001
WWAN capability and integrated webcam

Display hinges for use with HP EliteBook 8530p computer models 495070-001
Display hinges for use with HP EliteBook 8530w computer models 502334-001
Display inverter 487431-001
Display panel enclosure 600907-001
Display cable 600908-001
(2) Switch cover 495073-001
LED board (includes cable) 501232-001
(3) Keyboard with pointing stick (includes pointing stick and pointing stick cable)
For use in Belgium 495042-A41
For use in Brazil 495042-201
For use in the Czech Republic 495042-221
For use in Denmark 495042-081
For use in France 495042-051
For use in French Canada 495042-121
For use in Germany 495042-041
For use in Greece 495042-DJ1
For use in Hungary 495042-211
For use in Iceland 495042-DD1
For use in Israel 495042-BB1
For use in Italy 495042-061
For use in Japan 495042-291
For use in Latin America 495042-161
For use in the Netherlands 495042-B31
For use in Norway 495042-091
For use in Portugal 495042-131
For use in Russia 495042-251
For use in Saudi Arabia 495042-171
For use in Slovakia 495042-231
For use in Slovenia 495042-BA1
For use in South Korea 495042-AD1
For use in Spain 495042-071
For use in Sweden 495042-B71
For use in Switzerland 495042-BG1

22 Chapter 3 lllustrated parts catalog



Item Description Spare part number
For use in Taiwan 495042-AB1
For use in Thailand 495042-281
For use in Turkey 495042-141
For use in the United Kingdom 495042-031
For use in the United States 495042-001
(4) Top cover
NOTE: The top cover spare part kits do not include the fingerprint reader board and
cable. The fingerprint reader board and cable are available using spare part number
495063-001.
For use with computer models with Core2 Duo or Extreme Dual-Core processors 502335-001
For use with HP EliteBook 8530w computer models with Quad Core processors 502336-001
For use with HP EliteBook 8530p computer models 495068-001
Fingerprint reader board (not illustrated; includes fingerprint reader board cable) 495063-001

()

TouchPad (includes TouchPad cable)

With 3 TouchPad buttons and 3 pointing stick buttons for use with keyboards with pointing
stick (includes TouchPad cable)

(6)

WLAN module

Intel Wi-Fi Link 1300 802.11a/b/g/n 1x2WLAN module with iAMT 4.0 support:

e  For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the
Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong
Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Viethnam

480985-001 or
506078-001

Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support:

e  For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the
Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong
Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

480986-001 or
506679-001

Intel Wi-Fi Link 5100 802.11 a/b/g 1x2 WLAN Module with iAMT 4.0 support:

° For use in Russia, Ukraine, and Pakistan

482957-001 or

506680-001
(7) Fan

For use with the HP EliteBook 8530p computer models or the HP EliteBook 8530w 495079-001
computer models
For use with the Quad Core processor 495080-001
Heat sink (includes a heat sink clip and replacement thermal material)
Thermal Material Kits (not illustrated)
For use with the Quad Core processor and nVidia graphics card 501116-001
For use with the Quad Core processor and ATI graphics card 495074-001

Computer major components
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Item Description Spare part number
For use with the Dual-Core processor and nVidia graphics card 495075-001
For use with the Dual-Core processor and ATI graphics card 501117-001

(8) Graphics card (includes replacement thermal material)
ATI M86M ATI Mobility Radeon HD 3650 graphics card with 256 MB of graphics subsystem 495081-001
memory (supports Hypermemory)
ATI M86M ATI Mobility FireGL V5700 graphics card with 256 MB of graphics subsystem 502337-001
memory (supports Hypermemory)
nVidia NB9P-GLM2 graphics card with 512 MB of graphics subsystem memory (supports 502338-001
Quadro FX 770M)
Plastics Kit (see Plastics Kit on page 27 for more Plastics Kit spare part information): 495076-001

(9a) ExpressCard slot protective insert

(9b) Memory module compartment cover

(9c) Bluetooth module cover

(9d) Hard drive cover
Base enclosure rubber screw covers (2, not illustrated)
Computer feet (4, not illustrated)

(10) Processor
Intel Core2 Extreme processors
QX9300, 2.53-GHz Quad Core processor (12-MB L2 cache, 1066-MHz FSB) 501107-001
X9100, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 501106-001
Intel Core2 Quad processors
Q9100, 2.26-GHz processor (6-MB L2 cache, 1066-MHz FSB) 506808-001
Q9000, 2.0-GHz processor (6-MB L2 cache, 1066-MHz FSB) 508257-001
Intel Core2 Duo processors
T9900, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 618809-001
T9800, 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB) 515897-001
T9600, 2.8-GHz processor (6-MB L2 cache, 1066-MHz FSB) 495041-001
T9550, 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB) 515896-001
T9400, 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 495040-001
P9600, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618812-001
P9500, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB) 515895-001
P8800, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618810-001
P8700, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618811-001
P8600, 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 495039-001
P8400, 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 495038-001
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Item Description Spare part number
(11) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The

modem module cable is included in the Cable Kit, spare part number 495064-001. See

Cable Kit on page 28 for more Cable Kit spare part number information.

For use in all countries except for Asia Pacific and Japan 461750-001

For use in Asia Pacific and Japan 461750-011
(12) SIM not spared
(13) System board

For use in all countries and regions except Russia and China:

e  Foruse in HP EliteBook 8530w models with Intel Core2 Quad-Core processors 500906-001

e  Foruse in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core 500905-001

processors

° For use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors 500907-001

For use only in Russia and China:

e  Foruse in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core 510349-001

processors

e  Foruse in HP EliteBook 8530w models with Intel Core2 Quad-Core processors 510350-001

° For use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors 510348-001
(14) RTC battery 501115-001
(15) Speaker assembly 495072-001
(16) USB/audio board (includes USB board cable and audio board cable) 495065-001
(17) 8-cell, 2.55-Ah (73-Wh) Li-ion battery

For use in all countries and regions except for Japan 493976-001

For use in Japan 534057-291
(18) Base enclosure (includes rubber feet)

For use with HP EliteBook 8530w computer models with Quad Core processor 495083-001

For use with HP EliteBook 8530p computer models 495082-001
(19) Optical drive (includes bezel)

DVD+RW and CD-RW SuperMulti DL Combo Drive with LightScribe 495061-001

Blu-ray Disc ROM with SuperMulti DVD+/-R/RW DL Drive 495062-001

DVD-ROM Drive 495060-001
(20) Memory modules (PC2-6400, 667-MHz, DDR2)

4-GB 598855-001

2-GB 598858-001

1-GB 598861-001
(21) Optical drive bracket 502332-001

Computer major components
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Item Description Spare part number

(22) WWAN module

HP un2400 Mobile Broadband Module 483377-001

(23) Broadcom Bluetooth module (does not include Bluetooth module cable)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 495064-001. See Cable Kit on page 28 for more Cable Kit
spare part number information.

For use in all countries and regions 483113-001

(24) Hard drive (includes hard drive bracket)

500-GB, 7200-rpm 634924-001
500-GB, 5400-rpm 634632-001
320-GB, 7200-rpm 603783-001
250-GB, 7200-rpm 495059-001
160-GB, 7200-rpm 483186-001
160-GB, 7200-rpm (Seagate only) 580297-001
160-GB, 5400-rpm 514071-001
128-GB solid-state drive 574721-001
HP Intel 80-GB solid-state drive 636545-001
80-GB solid-state drive 501113-001

Cable Kit (not illustrated; see Cable Kit on page 28 for more Cable Kit spare part number 495064-001
information)

Hard drive hardware kit (includes rails and screws) 634022-001
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Plastics Kit
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Item Description Spare part number
Plastics Kit: 495076-001

(1) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)

(3) Bluetooth module cover

(4) Computer feet (4)

(5) ExpressCard slot protective insert
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Cable Kit

F

Item  Description Spare part number
Cabile Kit: 495064-001
(1) RJ-11 connector cable

(2) Microphone

(3) USB/audio cable
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Mass storage devices

Item  Description Spare part number

(1) Optical drive

DVD+RW and CD-RW SuperMulti DL Combo Drive with LightScribe 495061-001
Blu-ray Disc ROM with SuperMulti DVD+R/RW DL Drive 495062-001
DVD-ROM Drive 495060-001
(2) Optical drive bracket 502332-001

(3) Hard drive (includes bracket)

500-GB, 7200-rpm 634924-001
500-GB, 5400-rpm 634632-001
320-GB, 7200-rpm 603783-001
250-GB, 7200-rpm 495059-001
160-GB, 7200-rpm 483186-001
160-GB, 7200-rpm (Seagate only) 580297-001
160-GB, 5400-rpm 514071-001
128-GB solid-state drive (SSD) 574721-001
HP Intel 80-GB solid-state drive 636545-001
80-GB solid-state drive 501113-001
Hard drive hardware kit (includes rails and screws) 634022-001
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Miscellaneous parts

Description Spare part number

AC adapters

90-W AC adapter, 3P/RC 463955-001
90-W AC adapter, RC/V EM (for use in India) 535593-001
90-W AC adapter, RC/V 3W 613153-001
90-W AC adapter, RC/V EM 3W (for use only in India) 613160-001
90-W AC adapter, RC/V 3W 620656-001
120-W AC adapter, 3P/RC 463953-001
120-W AC adapter, RC/V 3W 613154-001
150-W AC adapter, 3P/RC 463954-001
150-W AC adapter, RC/V 3W 613156-001
180-W AC adapter, 3P/RC 463952-001
External MultiBay Il 366143-001
External MultiBay Il power cable and stand 366144-001
HP Extended Life Battery 456946-001
MultiBay 8X DVD-ROM Drive 373314-001
MultiBay 24X DVD/CD-RW Combo Drive 373315-001
Nylon carrying case 325814-001
USB 1.1 diskette drive 359118-001

Power cords:

For use in Australia 490371-011
For use in Brazil 490371-201
For use in Europe, the Middle East, and Africa 490371-021
For use in Israel 490371-BB1
For use in Italy 490371-061
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in the United Kingdom 490371-031
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Description Spare part number

For use in the United States 490371-001

Screw Kit 495077-001
e  Phillips PM3.0x5.0 screw

° Phillips PM2.5%9.0 captive screw

° Phillips PM2.5%7.0 screw

° Phillips PM2.5x%5.0 screw

e  Phillips PM2.5x3.0 screw

e  Phillips PM2.0x11.0 captive screw

e  Phillips PM2.0%5.0 captive screw

° Phillips PM2.0%5.0 screw

° Phillips PM2.0%4.0 barrel screw

° Phillips PM2.0x%3.0 screw

e  Phillips PM2.0x3.0 broadhead screw
e  Torx T8BM2.5x12.0 captive screw

e  Torx T8M2.5x8.0 screw

e  Torx T8M2.5%7.0 captive screw

Sequential part number listing

Spare part Description
number

456946-001 HP Extended Life Battery

461750-001 Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 485064-001. See Cable Kit on page 28 for more Cable
Kit spare part number information.

461750-011 Modem module for use in Asia-Pacific and Japan.

463952-001 180-W AC adapter

463953-001 120-W AC adapter

463954-001 150-W AC adapter

463955-001 90-W AC adapter

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

Sequential part number listing

31



Spare part Description
number

480986-001 Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

482957-001 Intel Wi-Fi Link 5100 802.11 a/b/g 1x2 WLAN Module with iAMT 4.0 support for use in Russia, Ukraine, and
Pakistan

483113-001 Bluetooth module for use in all countries and regions

483186-001 160-GB, 7200-rpm hard drive

483377-001 HP un2400 Mobile Broadband Module

486565-001 Pointing stick

487431-001 Display inverter

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061 Power cord for use in Italy

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

493976-001 8-cell, 2.55-Ah (73-Wh) Li-ion battery for use in all countries and regions except Japan

495038-001 Intel Core2 Duo P8400, 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB)

495039-001 Intel Core2 Duo P8600, 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB)

495040-001 Intel Core2 Duo T9400, 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB)

495041-001 Intel Core2 Duo T9600, 2.8-GHz processor (6-MB L2 cache, 1066-MHz FSB)

495042-001 Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cables)

495042-031 Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cables)

495042-041 Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

495042-051 Keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

495042-061 Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

495042-071 Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)

495042-081 Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)
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number

495042-091 Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

495042-121 Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

495042-131 Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

495042-141 Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

495042-161 Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

495042-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

495042-201 Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cables)

495042-211 Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

495042-221 Keyboard with pointing stick for use in the Czech Republic (includes keyboard and pointing stick cables)

495042-231 Keyboard with pointing stick for use in Slovakia (includes keyboard and pointing stick cables)

495042-251 Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

495042-281 Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

495042-291 Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cables)

495042-A41 Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

495042-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

495042-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

495042-B31 Keyboard with pointing stick for use in the Netherlands and Europe (includes keyboard and pointing stick
cables)

495042-B71 Keyboard with pointing stick for use in Sweden (includes keyboard and pointing stick cables)

495042-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

495042-BB1 Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)

495042-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)

495042-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

495042-DJ1 Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

495043-001 15.4-in WXGA display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

495044-001 15.4-in WSXGA+ display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability (includes 3 WLAN antenna transceivers and 2 WWAN antenna transceivers and
cables)

495045-001 15.4-in WUXGA display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

495046-001 15.4-in WXGA display assembly for use with HP EliteBook 8530w computer models equipped with WLAN
and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

495047-001 15.4-in WSXGA+ display assembly for use with HP EliteBook 8530w computer models equipped with
WLAN and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)
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495048-001 15.4-in WUXGA display assembly for use with HP EliteBook 8530w computer models equipped with WLAN
and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

495049-001 15.4-in WXGA display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

495050-001 15.4-in WSXGA+ display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

495051-001 15.4-in WUXGA display assembly for use with HP EliteBook 8530p computer models equipped with WLAN
and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

495059-001 250-GB, 7200-rpm hard drive (includes hard drive bracket)

495060-001 DVD-ROM Drive

495061-001 DVD+RW and CD-RW SuperMulti DL Combo Drive with LightScribe

495062-001 Blu-ray Disc ROM with SuperMulti DVD+R/RW DL Drive

495063-001 Fingerprint reader board (includes fingerprint reader board cable)

495064-001 Cable Kit (see Cable Kit on page 28 for more Cable Kit spare part information)

495065-001 USB/audio board (includes USB cable and audio cable)

495068-001 Top cover for use with HP EliteBook 8530p computer models

495070-001 Display hinges for use with HP EliteBook 8530p computer models

495072-001 Speaker assembly

495073-001 Switch cover (includes LED board and cable)

495074-001 Thermal Material Kit for use with the Quad Core processor and ATI graphics card

495075-001 Thermal Material Kit for use with the Dual-Core processor and nVidia graphics card

495076-001 Plastics Kit (see Plastics Kit on page 27 for more Plastics Kit spare part information)

495077-001 Screw Kit

495078-001 Rubber Kit

495079-001 Fan for use with the HP EliteBook 8530p computer models or HP EliteBook 8530w computer models

495080-001 Fan for use with HP EliteBook 8530w computer models with the Quad Core processor

495081-001 ATI M86M ATI Mobility Radeon HD 3650 graphics card with 256 MB of graphics subsystem memory
(supports Hypermemory; includes replacement thermal material)

495082-001 Base enclosure (includes rubber feet) for use with HP EliteBook 8530p computer models

495083-001 Base enclosure (includes rubber feet) for use with HP EliteBook 8530w computer models

495084-001 Wireless Antenna Kit

495085-001 ExpressCard assembly

500905-001 System board for use in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core processors

500906-001 System board for use in HP EliteBook 8530w models with Intel Core2 Quad-Core processors
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500907-001 System board for use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors

501106-001 Intel Core2 Extreme X9100, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB)

501107-001 Intel Core2 Extreme QX9300, 2.53-GHz processor (12-MB L2 cache, 1066-MHz FSB)

501111-001 Display bezel for use with HP EliteBook 8530p computer models equipped with WLAN and WWAN
capability

501112-001 Display bezel for use with HP EliteBook 8530p computer models equipped with WLAN and WWAN
capability and integrated webcam

501113-001 80-GB solid-state drive (SSD)

501115-001 RTC battery

501116-001 Thermal Material Kit for use with the Quad Core processor and nVidia graphics card

501117-001 Thermal Material Kit for use with the Dual-Core processor and ATI graphics card

501232-001 LED board (includes cable)

502332-001 Optical drive bracket

502334-001 Display hinges for use with HP EliteBook 8530w computer models

502335-001 Top cover for use with computer models with Core2 Duo or Extreme Dual-Core processors

502336-001 Top cover for use with HP EliteBook 8530w computer models with Quad Core processors

502337-001 ATI M86M ATI Mobility FireGL V5700 graphics card with 256 MB of graphics subsystem memory (supports
Hypermemory; includes replacement thermal material)

502338-001 nVidia NBOP-GLM2 graphics card with 512 MB of graphics subsystem memory (supports Quadro FX 770M;
includes replacement thermal material)

506678-001 Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam

506679-001 Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support for use in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti,
Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietham

506680-001 Intel Wi-Fi Link 5100 802.11 a/b/g 1x2 WLAN Module with iAMT 4.0 support for use in for use in Russia,
Ukraine, and Pakistan

506807-001 TouchPad with 3 TouchPad buttons and 3 pointing stick buttons (for use with keyboards with pointing stick;
includes TouchPad cable)

506808-001 Intel Core2 Quad Q9100, 2.26-GHz processor (6-MB L2 cache, 1066-MHz FSB)

506809-001 15.4-in WXGA display assembly for use with HP EliteBook 8530w computer models equipped with WLAN
and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

506810-001 15.4-in WSXGA+ display assembly for use with HP EliteBook 8530w computer models equipped with
WLAN and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables
and 2 WWAN antenna transceivers and cables)
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506811-001

15.4-in WUXGA display assembly for use with HP EliteBook 8530w computer models equipped with WLAN
and WWAN capability and integrated webcam (includes 3 WLAN antenna transceivers and cables and 2
WWAN antenna transceivers and cables)

506812-001

Display bezel for use with HP EliteBook 8530w computer models equipped with WLAN and WWAN
capability

506813-001

Display bezel for use with HP EliteBook 8530w computer models equipped with integrated webcam and
WLAN and WWAN capability

508257-001

Intel Core2 Quad Q9000, 2.00-GHz processor (6-MB L2 cache, 1066-MHz FSB)

510348-001

System board for use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors only in
Russia and China

510349-001

System board for use in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core processors only
in Russia and China

510350-001

System board for use in HP EliteBook 8530w models with Intel Core2 Quad-Core processors only in Russia
and China

514071-001

160-GB, 5400-rpm hard drive

515889-001

15.4-in WXGA display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, and WLAN and WWAN capability (includes 3 WLAN antenna
transceivers and cables and 2 WWAN antenna transceivers and cables)

515890-001

15.4-in WSXGA+ display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, and WLAN and WWAN capability (includes 3 WLAN antenna
transceivers and cables and 2 WWAN antenna transceivers and cables)

515891-001

15.4-in WUXGA display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, and WLAN and WWAN capability (includes 3 WLAN antenna
transceivers and cables and 2 WWAN antenna transceivers and cables)

515892-001

15.4-in WXGA display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, WLAN and WWAN capability, and integrated webcam (includes 3
WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

515893-001

15.4-in WSXGA+ display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, WLAN and WWAN capability, and integrated webcam (includes 3
WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

515894-001

15.4-in WUXGA display assembly for use with HP EliteBook 8530w computer models equipped with Intel
Core2 Extreme and Quad processors, WLAN and WWAN capability, and integrated webcam (includes 3
WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

515895-001

Intel Core2 Duo P9500, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB)

515896-001

Intel Core2 Duo T9550, 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB)

515897-001

Intel Core2 Duo T9800, 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB)

534057-291

8-cell, 2.55-Ah (73-Wh) Li-ion battery for use in Japan

535593-001

90-W AC adapter, RC/V EM (for use in India)

574721-001

128-GB solid-state drive (SSD)

580297-001

160-GB, 7200-rpm hard drive (Seagate only)

598855-001

4-GB memory module (PC2-6400, 800-MHz, DDR2)

598858-001

2-GB memory module (PC2-6400, 800-MHz, DDR2)

36 Chapter 3 lllustrated parts catalog



Spare part Description

number

598861-001 1-GB memory module (PC2-6400, 800-MHz, DDR2)

600907-001 Display panel enclosure

600908-001 Display cable

603783-001 320-GB, 7200-rpm hard drive (includes hard drive bracket)

613153-001 90-W AC adapter, RC/V 3W

613154-001 120-W AC adapter, RC/V 3W

613156-001 150-W AC adapter, RC/V 3W

613160-001 90-W AC adapter, RC/V EM 3W for use only in India

618809-001 Intel Core2 Duo T9900, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB)
618810-001 Intel Core2 Duo P8800, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB)
618811-001 Intel Core2 Duo P8700, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB)
618812-001 Intel Core2 Duo P9600, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB)
620656-001 90-W AC adapter, RC/V 3W

634022-001 Hard drive hardware kit (includes rails and screws)

634632-001 500-GB, 5400-rpm hard drive

634924-001 500-GB, 7200-rpm hard drive

636545-001 HP Intel 80-GB solid-state drive
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Phillips PO and P1 screwdrivers

° Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

@NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

ACAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm £10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 97 screws and screw locks, in 17 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Product name (1). This is the product name affixed to the front of the computer.

Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

e  Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

e  Model description (4). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

e  Warranty period (5). This number describes the duration (in years) of the warranty period for the
computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Plastics Kit, spare
part number 495076-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number
8-cell, 2.55-Ah (73-Wh) Li-ion battery for use in all countries and regions except Japan 493976-001
8-cell, 2.55-Ah (73-Wh) Li-ion battery for use in Japan 534057-291

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside-down on a flat surface, with the battery bay toward you.
2. Slide the battery release latch (1) to release the battery.

3.  Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM

@NOTE: This section applies only to computer models with WWAN capability.

»NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the SIM:

1.  Pressin on the SIM (1). (The module is partially ejected from the SIM slot.)
2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Optical drive

@NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
DVD+RW and CD-RW SuperMulti DL Combo Drive with LightScribe 495061-001
Blu-ray Disc ROM with SuperMulti DVD+R/RW DL Drive 495062-001
DVD-ROM Drive 495060-001
Optical drive bracket 502332-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the optical drive:
1. Position the computer with the right side toward you.

2. Remove the Phillips PM2.5%12.0 captive screw (1) that secures the optical drive to the
computer.

3. Push the optical drive tab (2) to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

5. Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.
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6. Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

i
-
i
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Reverse this procedure to install an optical drive.
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Display inverter

E%?NOTE: If it has been determined that the display inverter is the component that must be replaced to
complete the computer repair, the display assembly does not have to be removed. Follow the
procedures in this section to replace the display inverter. For information on replacing the display
assembly and the display hinges, see Display assembly on page 69.

Description Spare part number

Display inverter (includes 2-sided tape) 487431-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel.
4

Remove the two Phillips PM2.5x7.0 screws (2) that secure the display bezel bottom edge to the
display assembly.

5. Flex the inside edges of the left and right sides (1) and the display bezel bottom edge (2) until
the bezel disengages from the display assembly.
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6. Release the display bezel bottom edge (3) from the display assembly.

oy o,

7. Remove the two Phillips PM2.5x5.0 screws (1) that secure the display inverter to the display
enclosure.

8. Release the inverter (2) from the display enclosure as far as the display panel cable and
backlight cable allow.

9. Disconnect the backlight cable (3) and the display panel cable (4) from the display inverter.

10. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Hard drive

E%?NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number
500-GB, 7200-rpm hard drive 634924-001
500-GB, 5400-rpm hard drive 634632-001
320-GB, 7200-rpm hard drive 603783-001
250-GB, 7200-rpm hard drive 495059-001
160-GB, 7200-rpm hard drive 483186-001
160-GB, 7200-rpm hard drive (Seagate only) 580297-001
160-GB, 5400-rpm hard drive 514071-001
128-GB solid-state drive (SSD) 574721-001
HP Intel 80-GB solid-state drive 636545-001
80-GB solid-state drive 501113-001
Hard drive hardware kit (includes rails and screws) 634022-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the hard drive:
1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0x5.0 captive screws (1) that secure the hard drive cover to the
computer.
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3. Lift the right side of the hard drive cover (2), swing it to left, and remove the cover. The hard
drive cover is included in the Plastics Kit, spare part number 495076-001

4. Loosen the Phillips PM2.5%x11.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it
from the system board.

6. Remove the hard drive (4) from the hard drive bay.

If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0%5.0 hard drive

7.
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Component replacement procedures 53



Bluetooth module

@NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 495064-001. See Cable Kit
on page 28 for more Cable Kit spare part number information.

Description Spare part number

Bluetooth module for use in all countries and regions 483113-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the hard drive (see Hard drive on page 51).

Remove the Bluetooth module:
1. Position the computer upside-down with the rear toward you.

2. Remove the Bluetooth cover by lifting it straight up (1) and off the computer as far as the cable
connected to the module will allow.

E%?NOTE: The Bluetooth module is housed in the cover.

3.  Remove the Bluetooth module from the clip in the cover by sliding it straight down and out of the
cover (2).

4. Disconnect the Bluetooth module cable (3) from the Bluetooth module.
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Reverse this procedure to reassemble and install the Bluetooth module.

RTC battery
Description Spare part number
RTC battery 501115-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the RTC battery:
1. Position the computer upside-down with the front toward you.

2. Loosen the two Phillips PM2.0x5.0 captive screws (1) that secure the memory module
compartment cover to the computer.

3. Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 495076-001.

4. Disconnect the RTC battery cable (1) from the system board.
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5. Slide the RTC battery (2) out of the rubber pouch on the bottom of the system board.

Reverse this procedure to install the RTC battery.
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Memory modules

Description Spare part number
1-GB (PC2-6400, 800-MHz, DDR2) 598861-001
2-GB (PC2-6400, 800-MHz, DDR2) 598858-001
4-GB (PC2-6400, 800-MHz, DDR2) 598855-001

Before removing the expansion memory module, follow these steps:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the expansion memory module:

1.
2,

Position the computer upside-down with the front toward you.

Loosen the two Phillips PM2.0x5.0 captive screws (1) that secure the memory module
compartment cover to the computer.

Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 495076-001.

Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)
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5. Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.

r__f"%NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install an expansion memory module.
Remove the primary memory module:

1. Spread the retaining tabs (1) on each side of the primary memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the primary memory module (2) by pulling the module away from the slot at an angle.

E?‘%NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary memory module.
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WWAN module

/\ CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP un2400 Mobile Broadband Module 483377-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5.  Remove the SIM (see SIM on page 46).
Remove the WWAN module:

1. Loosen the two Phillips PM2.0x5.0 captive screws (1) that secure the memory module
compartment cover to the computer.

2. Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 495076-001.

3. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

%%NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

4. Remove the two Phillips PM2.5x3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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5. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

E"%NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Keyboard

For use in: Spare part number For use in: Spare part number

Keyboards with pointing stick (includes pointing stick cable):

Belgium 495042-A41 The Netherlands and Europe 495042-B31
Brazil 495042-201 Norway 495042-091
The Czech Republic 495042-221 Portugal 495042-131
Denmark 495042-081 Russia 495042-251
France 495042-051 Saudi Arabia 495042-171
French Canada 495042-121 Slovakia 495042-231
Germany 495042-041 Slovenia 495042-BA1
Greece 495042-DJ1 Spain 495042-071
Hungary 495042-211 Sweden and Finland 495042-B71
Iceland 495042-DD1 Switzerland 495042-BG1
Israel 495042-BB1 Taiwan 495042-AB1
Italy 495042-061 Thailand 495042-281
Japan 495042-291 Turkey 495042-141
South Korea 495042-AD1 The United Kingdom 495042-031
Latin America 495042-161 The United States 495042-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the keyboard:

1. Turn the computer upside-down, with the rear toward you.
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2. Loosen the two Phillips PM2.5%9.0 captive screws that secure the keyboard to the computer.

—_—

3. Turn the computer right-side up, with the front toward you.
4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the 4 and f5 keys, between the f8 and f9 keys, and between the 112 and scroll
keys.

6. Lift the rear edge of the keyboard (2), and then rotate the keyboard forward until it rests upside-
down on top of the TouchPad.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.
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8. Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Modem module

@NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 495064-001. See Cable Kit on page 28
for more Cable Kit spare part number information.

Description Spare part number
Modem module 461750-001
Modem module for use in Asia Pacific and Japan 461750-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

Remove the modem module:
1. Turn the computer right-side up, with the front toward you.

2. Remove the Phillips PM2.0x4.0 barrel screws (1) that secure the modem module to the system
board.

3. Disconnect the modem module (2) from the system board by lifting it straight up.
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4. Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.

WLAN module

/\ CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description

Spare part number

Intel Wi-Fi Link 5100 802.11a/b/g/n 1x2 WLAN module with iAMT 4.0 support:

e  Foruse in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United
States, Venezuela, and Vietnam

480985-001 or
506678-001

Intel Wi-Fi Link 5300 802.11a/b/g/n 3x3 WLAN module with iAMT 4.0 support:

e  Foruse in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United
States, Venezuela, and Vietnam

480986-001 or
506679-001

Intel Wi-Fi Link 5100 802.11 a/b/g 1x2 WLAN Module with iAMT 4.0 support:

° For use in Russia, Ukraine, and Pakistan

482957-001 or
506680-001

Before removing the WLAN module, follow these steps:

1.

the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

and then unplugging the AC adapter from the computer.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
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4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 61).

Remove the WLAN module:
1. Turn the computer right-side up, with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

E’%NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2)
is connected to the middle terminal on the WLAN module.

3. Remove the two Phillips PM2.0x4.0 barrel screws (3) that secure the WLAN module to the
computer. (The edge of the module opposite the slot rises away from the computer.)

4. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

r__ij?’NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.

Switch cover

Description Spare part number

Switch cover (includes LED board and cable) 495073-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4.
5.

Remove the battery (see Battery on page 45).

Remove the keyboard (see Keyboard on page 61).

Remove the switch cover:

1.
2,

Turn the computer upside-down, with the rear toward you.

Remove the three Phillips PM2.0x2.0 broadhead screws that secure the switch cover to the
computer.

[ | e | e e e e
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Turn the computer right-side up, with the front toward you.
Open the computer as far as possible.

Release the switch cover by lifting the left and right inside edges of the switch cover (1) until it
disengages from the computer.

Lift the switch cover (2) up and forward and rest it on the computer while being careful not to
disconnect the LED board cable from the system board.
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7. Disconnect the LED board cable (1) from the ZIF connector on the system board, and then
remove the switch cover from the computer (2).

Reverse this procedure to install the switch cover.
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Display assembly

Description Spare part number

Display assemblies for use with HP EliteBook 8530p computer models equipped with WLAN and WWAN capability (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA 495043-001
15.4-in, WSXGA+ 495044-001
15.4-in, WUXGA 495045-001

Display assemblies for use with HP EliteBook 8530w computer models equipped with WLAN and WWAN capability (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA 495046-001
15.4-in, WSXGA+ 495047-001
15.4-in, WUXGA 495048-001

Display assemblies for use with HP EliteBook 8530p computer models equipped WLAN and WWAN capability and
integrated webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA 495049-001
15.4-in, WSXGA+ 495050-001
15.4-in, WUXGA 495051-001

Display assemblies for use with HP EliteBook 8530w computer models equipped with WLAN and WWAN capability and
integrated webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-in, WXGA 506809-001
15.4-in, WSXGA+ 506810-001
15.4-in, WUXGA 506811-001

Display assemblies for use with HP EliteBook 8530w computer models equipped with Intel Core2 Extreme and Quad
processors, and WLAN and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

15.4-in, WXGA 515889-001
15.4-in, WSXGA+ 515890-001
15.4-in, WUXGA 515891-001

Display assemblies for use with HP EliteBook 8530w computer models equipped with Intel Core2 Extreme and Quad
processors, WLAN and WWAN capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna
transceivers and cables)

15.4-in, WXGA with integrated webcam 515892-001
15.4-in, WSXGA+ with integrated webcam 515893-001
15.4-in, WUXGA with integrated webcam 515894-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 65) and the WWAN module (see WWAN module on page 59).

6. Remove the following components:

a. Keyboard (see Keyboard on page 61)

b. Switch cover (see Switch cover on page 66)

Remove the display assembly:
1. Position the computer right-side up with the front toward you.
2. Disconnect the display panel cable (1) from the system board.

3.  Remove the wireless antenna cables from the clips (2) and (3) and routing channels (4) built into
the top cover.

4. Position the computer upside-down with the rear toward you.
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5.  Remove the following:
(1) One round screw cover on each side
(2) One large round screw cover and one wedge screw cover on each side
(3) Four Torx T8BM2.5%7.0 screws
(4) One Phillips PM2.5%5.0 screw in the battery bay

6. Remove the two Torx T8M2.5x7.0 screws (1) that secure the display assembly to the computer.
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7. Lift the display assembly (2) straight up and remove it.

/\ CAUTION: When installing the display assembly, be sure that the 4 wireless antenna cables
routed out of the display right hinge are routed and arranged properly. Each antenna cable has
an exposed section of cable and a metallic grounding sleeve (1). The grounding sleeve must
completely cover the exposed section of cable. Each cable must be secured inside a space in
the copper grounding clip (2). Left to right, the cables must be installed in a white, yellow, red,
black sequence.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
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8.

If it is necessary to replace the display bezel or display hinges, remove the following:
(1) Four rubber screw covers on the display bezel top edge

(2) Two rubber screw covers on the display bezel bottom edge

(3) Four Phillips PM2.5%7.0 screws on the display bezel top edge

(4) Two Phillips PM2.5x7.0 screws on the display bezel bottom edge

@NOTE: See Display inverter on page 49 for display inverter replacement instructions.

10.

Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the
display bezel until the bezel disengages from the display enclosure.

Remove the display bezel (3). The display bezel is available using the following spare part
numbers:

e 501111-001 (for use with HP EliteBook 8530p computer models equipped with WLAN and
WWAN capability)

e 501112-001 (for use with HP EliteBook 8530p computer models equipped with WLAN and
WWAN capability and inegrated webcam)

e 506812-001 (for use with HP EliteBook 8530w computer models equipped with WLAN and
WWAN capability)

e 506813-001 (for use with HP EliteBook 8530w computer models equipped with WLAN and
WWAN capability and integrated webcam)
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11. Ifitis necessary to replace the display hinges, remove the four Phillips PM2.5x5.0 screws (1)
that secure each display hinge to the display panel.

12. Remove the display hinges (2). The left and right display hinges are available using spare part
number 495070-001.

13. Remove the two Phillips PM2.5%5.0 screws (1) that secure the display panel to the display
enclosure.

The enclosure is available using spare part number 600907-001. The display cable is available
using spare part number 600908-001.
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14. Remove the display panel (2).

Reverse this procedure to reassemble and install the display assembly.

Component replacement procedures 75



Top cover

Description Spare part number
For use with computer models with Core2 Duo or Extreme Dual-Core processors 502335-001
For use with HP EliteBook 8530w computer models with Quad Core processors 502336-001
For use with HP EliteBook 8530p computer models 495068-001
Fingerprint reader board (includes fingerprint reader board cable) 495063-001

Before removing the top cover, follow these steps:

1.

Rem
1.
2.
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Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

d. Switch cover (see Switch cover on page 66)

e. Display assembly (see Display assembly on page 69)

ove the top cover:
Turn the computer upside-down, with the front toward you.

Remove the two rubber screw covers (1). The rubber screw covers are included in the Plastics
Kit, spare part number 495076-001.

Remove the seven Torx T8M2.5x7.0 screws (2) that secure the top cover to the base enclosure.
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4. Remove the four Phillips PM 2.0x3.0 broadhead screws (3)

5.  Turn the computer right-side up, with the rear toward you.

6. Remove the four Torx T8M2.5%8.0 screws (1) and the two HM2.5x6.0 screw locks (2) that
secure the top cover to the computer.

7. Remove the microphone cable from the routing path in the top cover, and then disconnect the
microphone cable from the system board.
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8. Disconnect the TouchPad board ZIF cable (1) and the fingerprint reader board ZIF cable (2)
from the system board.

o~

9. Lift the rear edge of the top cover (1) and swing it up and forward until it rests at an angle.

10. Remove the top cover (2).

Reverse this procedure to install the top cover.
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TouchPad

E;"'/?NOTE: All TouchPad spare part kits include a TouchPad cable. The TouchPad cable is also
included in the Cable Kit, spare part number 495064-001.

Description Spare part number

With 3 TouchPad buttons and 3 pointing stick buttons for use with keyboards with pointing stick 506807-001

Before removing the TouchPad, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a.

b.

e.

f.

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)

Remove the TouchPad:

1.
2,

Turn the top cover upside-down, with the front toward you.

Remove the four Phillips PM2.0x3.0 screws that secure the TouchPad bracket to the top cover.
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3. Slide the bracket forward and remove it, routing the cable through the opening in the bracket.
4. Disconnect the TouchPad cable (1) from the system board.

5. Remove the TouchPad (2).

Reverse this procedure to install the TouchPad.
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Fan

Description Spare part number
For use with HP EliteBook 8530p computer models or HP EliteBook 8530w computer models 495079-001
For use with HP EliteBook 8530w computer models with Intel QX9300 Quad Core processor 495080-001

Before removing the fan, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).
Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

d. Switch cover (see Switch cover on page 66)

e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 76)

Remove the fan:

1.

2
3.
4

Position the computer right-side up, with the front toward you.
Disconnect the fan cable (1) from the system board.
Remove the two Torx 8M2.5x7.0 screws (2) that secure the fan to the base enclosure.

Lift the front edge of the fan to remove it from (3) from the base enclosure.

/‘o_i
|
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Reverse this procedure to install the fan.

@NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.
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Heat sink

Description

Spare part number

Heat sink (includes a heat sink clip and replacement thermal material)

Thermal Material Kits

For use with the Quad Core processor and nVidia graphics card 501116-001
For use with the Quad Core processor and ATI graphics card 495074-001
For use with the Dual-Core processor and nVidia graphics card 495075-001
For use with the Dual-Core processor and ATI graphics card 501117-001

Before removing the heat sink, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a.

b.

g.

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)

Fan (see Fan on page 81)

Remove the heat sink:

1.

Position the computer right-side up, with the front toward you.

Component replacement procedures

83



2.  Remove the four Torx T8M2.0x7.0 captive screws (1) and the four Torx T8M2.5%12.0 captive
screws (2) that secure the heat sink to the base enclosure.

3. Lift the right side of the heat sink (1) to disengage it from the graphics card.
4. Remove the heat sink (2) by sliding it to the right.

@NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1), (2),
and (3), the processor (1), the Northbridge chip (2), and various capacitors (3) each time the heat sink
is removed. Thermal material is included with all heat sink and processor spare part kits.
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Reverse this procedure to install the heat sink.
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Processor

@NOTE: All processor spare part Kits include replacement thermal material. The Thermal Material Kit
is also available using spare part numbers 501117-001 (for use with Dual-Core processor and ATI
graphics card), 495075-001 (for use with Dual-Core processor and nVidia graphics card), 495074-001
(for use with Quad Core processor and ATI graphics card), and 501116-001 (for use with Quad Core
processor and nVidia graphics card),

Description Spare part number
Intel Core2 Extreme QX9300, 2.53-GHz processor (12-MB L2 cache, 1066-MHz FSB) 501107-001
Intel Core2 Extreme X9100, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 501106-001
Intel Core2 Quad Q9100, 2.26-GHz processor (6-MB L2 cache, 1066-MHz FSB) 506808-001
Intel Core2 Quad Q9000, 2.0-GHz processor (6-MB L2 cache, 1066-MHz FSB) 508257-001
Intel Core2 Duo T9900, 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 618809-001
Intel Core2 Duo T9800, 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB) 515897-001
Intel Core2 Duo T9600, 2.8-GHz processor (6-MB L2 cache, 1066-MHz FSB) 495041-001
Intel Core2 Duo T9550, 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB) 515896-001
Intel Core2 Duo T9400, 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 495040-001
Intel Core2 Duo P9600, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618812-001
Intel Core2 Duo P9500, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB) 515895-001
Intel Core2 Duo P8800, 2.66-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618810-001
Intel Core2 Duo P8700, 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB) 618811-001
Intel Core2 Duo P8600, 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 495039-001
Intel Core2 Duo P8400, 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 495038-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

d. Switch cover (see Switch cover on page 66)
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e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 76)

g. Fan (see Fan on page 81)

h. Heat sink (see Heat sink on page 83)

Remove the processor:
1. Position the computer right-side up, with the front toward you.

2. Use aflat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

%%NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed
on the processor slot when you install the processor.

Reverse this procedure to install the processor.

Graphics card

@NOTE: All graphics card spare part kits include replacement thermal material.

Description Spare part number

ATI M86M ATI Mobility Radeon HD 3650 graphics card with 256 MB of graphics subsystem 495081-001
memory (supports Hypermemory)

ATI M86M ATI Mobility FireGL V5700 graphics card with 256 MB of graphics subsystem memory  502337-001
(supports Hypermemory)

nVidia NB9P-GLM2 graphics card with 512 MB of graphics subsystem memory (supports Quadro  502338-001
FX 770M)

Thermal Material Kits

For use with the ATI Quad Core processor 495074-001

For use with the nVidia Quad Core processor 501116-001
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Description Spare part number

For use with the ATI Dual-Core processor 501117-001

For use with the nVidia Quad Core processor 495075-001

Before removing the graphics card, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a.

b.

g.
h.

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)

Fan (see Fan on page 81)

Heat sink (see Heat sink on page 83)

Remove the graphics card:

1.
2.

Position the computer right-side up, with the front toward you.

Remove the two Phillips PM2.0x5.0 screws (1) that secure the graphics card to the computer.
(The edge of the board opposite the graphics card slot rises away from the computer.)
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3.  Remove the graphics card (2) by sliding it away from the graphics card slot at an angle.

@NOTE: The graphics card is designed with a notch (3) to prevent incorrect insertion.

Reverse this procedure to install the graphics card.

Speaker assembly

Description Spare part number

Speaker assembly 495072-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5.  Remove the following components:

a.

b.

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)
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Remove the speaker assembly:
1. Position the computer right-side up, with the front toward you.
2. Disconnect the speaker cable (1) from the system board.

3.  Remove the two Torx PM2.5%7.0 screws (2) that secure the speaker assembly to the base
enclosure.

4. Remove the speaker assembly (3) from the base enclosure.

‘;'79

Reverse this procedure to install the speaker assembly.

System board

@’NOTE: All system board spare part kits include replacement thermal material. The Thermal Material
Kit is also available using spare part numbers 413706-001 (for use in all countries or regions except
Japan and Asia countries and regions) and 445853-001 (for use only in Japan and Asia Pacific
countries and regions).

Description Spare part number

System boards for use in all countries and regions except Russia and China:

For use in HP EliteBook 8530w models with Intel Core2 Quad-Core processors 500906-001
For use in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core processors 500905-001
For use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors 500907-001

System boards for use only in Russia and China:

For use in HP EliteBook 8530w models with Intel Core2 Extreme Dual-Core processors 510349-001
For use in HP EliteBook 8530w models with Intel Core2 Quad-Core processors 510350-001
For use in HP EliteBook 8530p and 8530w models with Intel Core2 Duo processors 510348-001
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Before removing the system board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

d. Switch cover (see Switch cover on page 66)

e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 76)

g. Fan (see Fan on page 81)

h. Heat sink (see Heat sink on page 83)

i. Speaker assembly (see Speaker assembly on page 89)

j- Modem module (see Modem module on page 64)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

SIM (see SIM on page 46)

Memory module (see Memory modules on page 57)

WLAN module (see WLAN module on page 65)

WWAN module (see WWAN module on page 59)

Processor (see Processor on page 86)

Graphics card (see Graphics card on page 87)

ExpressCard assembly (see ExpressCard assembly on page 94)

Remove the system board:

1.

Position the computer right-side up, with the front toward you.
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2. Disconnect the following cables from the system board:
(1) RJ-11 connector cable
(2) USB/audio board cable

(3) Bluetooth module cable

3. Position the base enclosure with the rear panel toward you.

4. Remove the one black Phillips PM2.0x3.0 screw (1) that secures the system board frame to the
base enclosure.

5. Lift the system board (2) and frame and slide them to the right (3) to remove them from the base
enclosure.

|‘__°:"%NOTE: When removing the system board and frame, be sure that the USB/audio board cables
route cleanly through the openings in the system board frame.

Reverse the preceding procedure to install the system board.
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RJ-11 connector cable

E%?NOTE: The RJ-11 connector cable is included in the Cables Kit, spare part number 452198-001.

Before removing the RJ-11 connector cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a.

b.

j-

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)

Fan (see Fan on page 81)

Heat sink (see Heat sink on page 83)

Modem module (see Modem module on page 64)

System board (see System board on page 90)

Remove the RJ-11 connector cable:

1.
2.

Position the computer right-side up, with the front toward you.

Remove the RJ-11 connector (1) from the clip built into the base enclosure.
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3.

4,

Remove the RJ-11 connector cable from the clips and routing channel (2) built into the base
enclosure.

Remove the RJ-11 connector cable from the base enclosure.

Reverse this procedure to install the RJ-11 connector cable.

ExpressCard assembly

Description

Spare part number

ExpressCard assembly

495085-001

Before removing the ExpressCard assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a.

b.

Hard drive (see Hard drive on page 51)

Optical drive (see Optical drive on page 47)

Keyboard (see Keyboard on page 61)

Switch cover (see Switch cover on page 66)

Display assembly (see Display assembly on page 69)

Top cover (see Top cover on page 76)

Fan (see Fan on page 81)
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h. Heat sink (see Heat sink on page 83)

i. Modem module (see Modem module on page 64)

j.-  System board (see System board on page 90)

Remove the ExpressCard assembly:
1. Turn the system board upside-down, with the front toward you.

2.  Remove the four Phillips PM2.0x5.0 screws that secure the ExpressCard assembly to the
system board.

T
I
I
I

3. Detach the slots on the ExpressCard assembly from the tabs on the ExpressCard connector (1).

4. Remove the ExpressCard assembly (2).

Reverse this procedure to install the ExpressCard assembly.
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USB/audio board

Description Spare part number

USB/audio board (includes USB cable and audio cable) 495065-001

Before removing the USB/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 51)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 61)

d. Switch cover (see Switch cover on page 66)

e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 76)

g. Fan (see Fan on page 81)

h. Heat sink (see Heat sink on page 83)

i. Modem module (see Modem module on page 64)

j-  System board (see System board on page 90)

Remove the USB/audio board:
1. Position the computer right-side up, with the front toward you.
2. Disconnect the cable from the USB/audio board (1).

3.  Remove the Torx T82.5%8.0 screw (2) that secures the USB/audio board to the base enclosure.

96 Chapter4 Removal and replacement procedures



4. Lift the left side of the USB/audio board (3) until the USB and audio connectors disengage from
the openings in the base enclosure.

5. Remove the USB/audio board and cables from the base enclosure.

Reverse this procedure to install the USB/audio board.
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5 Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

= NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

=7 NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
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Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the keyboard arrow keys and then press enter, or
use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Ignore changes and exit, and then press enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

r__*:"/?NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press 10 to enter BIOS Setup.
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3. Use a pointing device or the arrow keys to select File > Restore defaults.
4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

= NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

= NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.

e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

@NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.
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Select

To do this

User Management (requires a BIOS administrator password)

° Create a new BIOS user account.

e View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enroliment (enabled by
default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Allow Reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enroliment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DriveLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this
System Diagnostics menu e  F1 System Information—Displays the following
information:

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

e  F2 Start-up Test—Verifies the system components
needed for starting the computer.

e  F3 Run-In Test—Runs a comprehensive check on
system memory.

e F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

e  F5 Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

E%?NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta Startup Menu delay (in seconds).

Enable/disable Custom Logo (disabled by default).

Enable/disable Display Diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (enabled by default).
Enable/disable SD Card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE Internal NIC boot (enabled by
default).

Set the Express Boot Popup delay in seconds.

Set the boot order.

Device Configurations °

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)
° IDE (Integrated Drive Electronics)

° RAID (select models only)
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Select

To do this

NOTE: Availability of the options above varies by
computer model.

e Enable/disable secondary battery fast charge (enabled
by default).

e  Enable/disable HP QuickLook 2 (enabled by default).

e  Enable/disable Virtualization Technology (select models
only; disabled by default).

e Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

e  Enable/disable Dual-Core CPU (select models only;
enabled by default).

e  Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options

e  Enable/disable the wireless button state (enabled by
default).

e  Enable/disable embedded WWAN device radio (select
models only; enabled by default).

° Enable/disable embedded Bluetooth device radio
(enabled by default).

e  Enable/disable the Network Interface Controller (LAN)
(enabled by default).

e  Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

e Enable/disable the fingerprint device (enabled by
default).

e Enable/disable a modem device (enabled by default).

e  Enable/disable the embedded WLAN device (enabled
by default).

e  Enable/disable LAN/WLAN switching (disabled by
default).

e  Enable the ambient light sensor (enabled by default).

e Enable/disable the Notebook Multibay device (enabled
by default).

e  Enable/disable the integrated camera (select models
only; enabled by default).
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Select To do this

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

o  Enable/disable the Smart Card slot.

e  Enable/disable the ExpressCard slot.

° Enable/disable the serial port.

° Enable/disable the parallel port.

e  Enable/disable the flash media reader.

e  Enable/disable the USB port.
CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the

advanced port replicator.

e  Enable/disable the 1394 port.

AMT Options NOTE: All AMT options are disabled by default.
e  Enable/disable Firmware Verbosity.
e  Enable/disable AMT Setup Prompt (CTRL-P).
e  Enable/disable USB Key Provisioning Support.
e  Enable/disable Unconfigure AMT on Next Boot.
e  Enable/disable Terminal Emulation Mode
° Enable/disable Firmware Progress Event Support.

° Enable/disable include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.
Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Length 26.0 cm 10.24 in
Width 35.7 cm 14.00 in
Height (front to rear) 2.8t03.4cm 1.10t0 1.34 in
Weight (equipped with optical drive, 8-cell battery, one 512-  2.77 kg 6.1 lbs
MB memory module, pointing stick, and TouchPad)
Input power
Operating voltage 19.0Vdc@4.74 A-90 W
Operating current 474 A
Temperature
Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 95%
Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia) -15mto 3,048 m 50 ft to 10,000 ft
Nonoperating (14.7 to 4.4 psia) -15mt0 12,192 m -50 ft to 40,000 ft
Shock
Operating 125 g, 2 ms, half-sine
Nonoperating 200 g, 2 ms, half-sine
Random vibration
Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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Metric

u.s.

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within

this range of temperatures.

15.4-in, WUXGA display specifications

Metric u.s.
Dimensions
Height 20.7 cm 8.151in
Width 33.1cm 13.03in
Diagonal 39.1 cm 15.39in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Pixel resolution

Pitch 0.197 x 0.197 mm
Format 1920 x 1200
Configuration RGB vertical stripe
Backlight CCFT

Character display 80 x 25

Total power consumption 7.0W

Viewing angle

+/-40 horizontal, +/-50° vertical (typical)
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15.4-in, WSXGA+ display specifications

Metric u.s.
Dimensions
Height 20.7 cm 8.151in
Width 33.1cm 13.03 in
Diagonal 39.1 cm 15.39in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Pixel resolution

Pitch 0.197 x 0.197 mm
Format 1680 x 1050
Configuration RGB vertical stripe
Backlight CCFT

Character display 80 x 25

Total power consumption 7.0W

Viewing angle

+/-40 horizontal, +/-50° vertical (typical)
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15.4-in, WXGA display specifications

Metric u.s.
Dimensions
Height 20.7 cm 8.15in
Width 33.1cm 13.03 in
Diagonal 39.1cm 15.39in
Number of colors Up to 16.8 million
Contrast ratio 200:1 (typical)
Brightness 180 nits (typical)
Pixel resolution
Pitch 0.197 x 0.197 mm
Format 1366 x 768
Configuration RGB vertical stripe
Backlight CCFT
Character display 80 x 25
Total power consumption 7.0W
Viewing angle +/-40 horizontal, +/-50° vertical (typical)
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Hard drive specifications

500-GB* 320-GB* 250-GB* 160-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 101g 101 g 101g 101g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3ms 3ms 3ms 3ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 1,048,576,000 625,141,400 488,397,168 312,560,640

Disc rotational speed 7200 and 5400 rpm 7200 rpm 7200 and 5400 rpm 7200 rpm and 5400
rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD*RW and CD-RW SuperMulti DL Combo Drive
specifications

Applicable disc

Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-l,
CD-I Bridge (Photo-CD, Video CD),

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-

Multisession CD (Photo-CD, CD-EXTRA, RW, DVD-RAM
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM
Center hole diameter 1.5cm (0.59 in)
Disc diameter
Standard disc 12cm (4.72in)
Mini disc 8.cm (3.151n)
Disc thickness 1.2 mm (0.047 in)
Track pitch 0.74 ym
Access time CD DVD
Random <175 ms <230 ms
Full stroke <285 ms <335 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds
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Blu-ray Disc ROM Drive with SuperMulti DVD*R/RW

Double Layer

Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,

MIXED MODE CD, CD-Il, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-

ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD
Random 170 ms 170 ms 230 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5cm (0.59 in)

Disc diameter

Standard disc

Mini disc

12 cm (4.72 in)

8.cm (3.151n)

Disc thickness

1.2 mm (0.047 in)

Track pitch 0.74 ym

Access time CD DVD
Random <100 ms <125 ms
Full stroke <175 ms <225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

512 KB

Data transfer rate

CD-R (24X)

3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X)

1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2

16.6 MB/s

Startup time

< 10 seconds

Stop time

< 3 seconds
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System DMA specifications

Hardware DMA

System function

DMAO Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller
DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications

Hardware IRQ System function

IRQO System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI1 OHCI 1394 host controller

TI1 PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad
IRQ13 Numeric data processor
IRQ14 Primary IDE channel
IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System 1/O address specifications

1/0 address (hex) System function (shipping configuration)
000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers
025 - 03F Unused

02E - 02F 87334 “Super I/0” configuration for CPU
040 - O5F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - O7F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0AO - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)
0A2 - 0BF Unused

0CO - ODF DMA controller no. 2

OEO - OEF Unused

OFO0 - OF1 Coprocessor busy clear/reset

OF2 - OFF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller
178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)
202 - 21F Unused
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1/0 address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370-377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)
3CO0 - 3DF VGA

3EO - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)
CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications

Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory
58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)
4GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
495077-001.
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Phillips PM2.0%x5.0 captive screw

=® [

mm Liobeotndon

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.0 mm 4.5 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover
by C-clips)

(2) Two screws that secure the memory module compartment cover to the computer (screws are
captured on the cover by C-clips)
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Phillips PM2.5%11.0 captive screw

E [y

Color Quantity Length Thread Head diameter

Black 2 11.0 mm 2.5 mm 5.0 mm
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Where used: One screw that secures the optical drive to the computer

Phillips PM3.0%x5.0 screw

=@ [m

SanmnEnmnmm

Color Quantity Length Thread Head diameter
Silver 4 5.0 mm 3.0 mm 5.0 mm
&
- o
i
- i
-

#
-
i

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Torx T8M2.5%8.0 screw

SON

mm Lot

Color Quantity Length Thread Head diameter

Black 23 8.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the display assembly to the computer

1
|
|
|
|

Where used: 4 screws that secure the display assembly to the computer

Torx T8BM2.5%x8.0 screw 123



Where used: 8 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the speaker assembly to the base enclosure
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Where used: 4 screws that secure the top cover to the top of the computer
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Phillips PM2.5%9.0 captive screw

2 |||||||||||

Color Quantity Length Thread Head diameter

Black 2 9.0 mm 2.5 mm 5.0 mm

Where used: 2 captive screws that secure the keyboard to the computer
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Black Torx 8M2.0x7.0 captive screw

mI||||I|n|I T

Color Quantity Length Thread Head diameter

Black 4 7.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the heat sink to the base enclosure
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Silver Torx 8M2.5x12.0 captive screw

2 |||||||||||

Color Quantity Length Thread Head diameter

Silver 4 12.0 mm 2.5 mm 4.5 mm

Where used: 4 screws that secure the heat sink to the base enclosure
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Phillips PM2.5%5.0 screw

=@ [pm

mm Lot

Color Quantity Length Thread Head diameter

Black 7 5.0 mm 2.5 mm 5.0 mm

Where used: 1 screw that secures each display hinge bracket to the display assembly

Phillips PM2.5%5.0 screw 129



Where used: 2 screws that secure the display inverter to the display assembly

i

Where used: 2 screws that secure the display panel to the display enclosure
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Phillips PM2.5%3.0 screw

E |||||||||||

I||||I||[|I||||I1|||I|||[I||||I

Color Quantity Length Thread Head diameter

Black 2 3.0 mm 25 4.5 mm

Where used: 2 screws that secure the WWAN module to the computer
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Phillips PM2.0%x3.0 broadhead screw

® P

Color Quantity Length Thread Head diameter

Black 7 3.0 mm 2.0 mm 4.5 mm

Where used: 3 screws that secure the switch cover to the computer

|
¥

S

Where used: 4 screws that secure the top cover to the base enclosure
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Black Phillips PM2.0%x3.0 screw

® [o

mm Lot

Color Quantity Length Thread Head diameter

Black 9 3.0 mm 2.0 mm 4.5 mm

Where used: 1 screw that secures the system board to the base enclosure
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Where used: 2 screws that secure each display hinge to the computer

Black Phillips PM2.5%x7.0 screw

=@ [

mm Lot

Color Quantity Length Thread

Head diameter

Black 6 7.0 mm 2.5 mm

5.0 mm

Where used: 6 screws that secure the display bezel to the display assembly
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Black Phillips PM2.0x4.0 barrel screw

o ammm

Color Quantity Length Thread Head diameter

Black 4 4.0 2.0 4.5

Where used: 2 screws that secure the WLAN module to the system board
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Silver HM2.5%6.0 hex screw locks

=@ (>

mm Lot

Color Quantity Length Thread Head diameter

Silver 2 6.0 mm 2.5 mm 6.0 mm

Where used: 2 hex screw locks that secure the top cover to the base enclosure
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Black Phillips PM2.0%x5.0 screw

- @ [m
i mnammm

Color Quantity Length Thread Head diameter

Black 6 5.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the graphics card to the system board

Black Phillips PM2.0x5.0 screw 137



8 Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

Backing up individual files and folders

Backing up the entire hard drive (select models only)
Scheduling automatic backups (select models only)
Creating system restore points

Recovering individual files

Restoring the computer to a previous state

Recovering information using recovery tools

@NOTE: For detailed instructions, perform a search for these topics in Help and Support.

=?NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:
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Store personal files in the Documents folder, and back it up regularly.
Back up templates that are stored in their associated programs.

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

@NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

E‘%NOTE: Be sure that the computer is connected to AC power before you start the backup process.

E%"%NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

=¥ NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

Backup and recovery in Windows Vista 139



E/%"NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

@NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

E‘%NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

=¥ NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

@NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

ACAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

E’%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.
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Follow the on-screen instructions.

Backup and recovery in Windows Vista 141


http://www.hp.com/support

Backup and Recovery in Windows XP

Backing up your information

@NOTE: You can recover only the files that you have previously backed up. HP recommends that
you use the Windows backup utility to create a hard drive backup as soon as you set up your
computer.

With the Windows backup utility, you can perform the following tasks:
e  Backing up your information regularly to protect your important system files

e Creating system recovery points that allow you to reverse undesirable changes to your computer
by restoring the computer to an earlier state

e  Scheduling backups at specific intervals or events

@NOTE: The Windows backup utility backs up only data files. The operating system, drivers, and
programs are located on the operating system disc and System Recovery disc that are included with
the computer.

When to back up

e  On aregularly scheduled basis

@NOTE: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

Backup suggestions
e Connect the computer to external power before performing backup and recovery procedures.
e  Create system recovery points.
e  Store personal files in the My Documents folder and back up these folders periodically.
e  Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.
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The screen image is added to the document.

d. Save the document.

Backing up individual files or folders

You can back up individual files or folders to an optional external hard drive or to a network drive.

=¥ NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up individual files or folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Follow the on-screen instructions.

Backing up all files and folders

When you back up all files and folders, you are saving all personal files and folders, all system files,
and configuration settings at one time.

=»NOTE: When you back up all files and folders, this does not include the operating system or
programs.

E%?NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

=»NOTE: A copy of the backup files can be stored on an optional external hard drive or on a network
drive.

To back up all files and folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Click All information on this computer, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points

When you back up system modifications since your last backup, you are creating system recovery
points. This allows you to save a snapshot of your hard drive at a specific point in time. You can then
recover back to that point if you want to reverse subsequent changes made to your system.
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E/?’NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:
e Before you add or extensively modify software or hardware

e  Periodically, whenever the system is performing optimally

=¥ NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since
that recovery point.

To create a system recovery point:

1. Select Start > All Programs > Accessories > System Tools > System Restore.
The System Restore window opens.

2. Click Create a new restore point, and then click Next.

3. Type a short description of the restore point. This will be used as the name of the restore point.

4. Click Create.

5

Follow the on-screen instructions.

Scheduling backups

You can schedule backups for the entire system, for recovery points, or for specific files and folders.
Backups can be scheduled at specific intervals (daily, weekly, or monthly) or at specific events, such
as at system restart or when you log on.

To schedule backups:

1. Select Start > All Programs > Accessories > System Tools > Schedule Tasks.
The Schedule Tasks window opens.

2. Double-click Add Scheduled Task, and then click Next.

3. Select Backup in the Application list, and then click Next.

4. Type a name for the backup, select when you want the backup to be performed, and then click
Next.

5. Enter your user name, password, and password again to confirm. Click Next, and then click
Finish.

Performing a recovery

The Windows backup utility helps you recover important files that you have previously backed up in
case of system failure.

@NOTE: To recover the operating system and programs, use the operating system disc and System
Restore disc that are included with the computer.
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:
1. If possible, back up all personal files.
2. Select Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard page opens.
3. Click Restore files and settings, and the click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground

Audio-in (microphone)

1 2 3
Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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External monitor

@O O00®
®000 W
©O000®G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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RJ-11 (modem)

i

123456
Pin Signal
1 Unused
2 Tip
3 Ring
4 Unused
5 Unused
6 Unused

LLTETTT
12345678
[ —

Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused
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Universal Serial Bus

1 2 3 4
I_-_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region

Accredited agency

Applicable note number

Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region

where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it

will be used.

5.  The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it

will be used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

ACAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

@NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

@NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).

Display 153



4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

t
i-

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.

154 Chapter 11 Recycling



10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19.
20.
21.
22,

Disconnect the display panel cable (1) from the LCD panel.

Remove the screws (2) that secure the LCD panel to the display rear panel.

Release the LCD panel (3) from the display rear panel.

Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part numbers
30, 31
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AMT options 105
AMT setup prompt (CTRL-P)
105
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supporty 105
firmware verbosity 105
terminal emulation mode 105
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boot 105
USB key provisioning support
105
antennas, disconnecting 59, 66
audio, product description 4
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audio-out jack
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scheduling 144
Backup and Restore Center 138,
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base enclosure, spare part

number 25, 34
battery
location 18

removal 45
spare part number
45
battery bay 18
battery latch 18
battery light 14, 15
BIOS Administrator password
100
Blu-ray Disc ROM Drive
specifications 112
Blu-ray Disc ROM with SuperMulti
DVDzR/RW DL Drive
removal 47
spare part number
47
Bluetooth module
removal 54
spare part number 32
spare part numbers 26, 54
Bluetooth module cover,
illustrated 27
boot options 103
boot order 103
bottom components 18
built-in device
ambient light sensor 104
Bluetooth device radio 104
embedded WLAN 104
fingerprint reader 104
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LAN/WLAN switching 104
modem 104
Network Interface Controller
(LAN) 104
Notebook Multibay 104

25, 31, 36,

25, 29, 34,

Wake on LAN 104
wireless button 104
WWAN device radio 104
built-in device options 104
buttons
info 11
pointing stick
power 11
presentation 12
TouchPad 10
volume mute 12
wireless 12

10, 13

Cc

Cable Kit
contents 28
spare part number

caps lock light 14
carrying case, spare part
number 30
chipset, product description 2
components
bottom 18
buttons 11
display 9
fingerprint reader 11
front 15
keys 12
left-side 16
lights 13
pointing devices 10
rear 17
right-side 17
switch 11
top 10
computer feet
illustrated 27

26, 28, 34
cables, service considerations 39



locations 44

spare part number 44
Computer Setup

accessing 98

Diagnostics menu 102

File menu 100

navigating and selecting 99

restoring factory settings 99

Security menu 100

System Configuration menu

103

using 99
computer specifications 106
connectors

docking 18

power 17

service considerations 39
creating a backup 138
creating recovery points 143

D
device configurations 103
Diagnostics menu 102
Disk Sanitizer 101
diskette drive
precautions 39
product description 4
spare part number 30
display assembly
removal 69
spare part numbers 20, 21,
33, 36, 69
display assembly with integrated
webcam
spare part numbers 34, 35,
36
display bezel
release 49
removal 73
spare part numbers 21, 22,
35, 36, 73
display bezel with integrated
webcam, spare part number 35
display cable, spare part number
22,37,74
display component recycling 152
display components 9

display hinge
removal 74

spare part number 22, 34, 35,
74

display inverter

removal 49

spare part number 22, 49
display panel

product description 2

removal 75
display panel enclosure, spare part

number 22, 37,74

display release latch 15
display specifications 107, 108,
109
display switch 12
docking connector 18
docking support, product
description 5
drive light 14,15
DriveLock password 101
DriveLock, automatic 101
drives
boot order 103
preventing damage 39
Dual-Core CPU 104
DVD-ROM Drive
precautions 39
removal 47
spare part number
34, 47
specifications 113
DVD/CD-RW Combo Drive
precautions 39
spare part number 30
DVDxRW and CD-RW SuperMulti
DL Combo Drive with LightScribe
removal 47
spare part number
47

25, 29, 30,

25, 29, 34,

E
electrostatic discharge 40
eSATA port 16
esc key 12
Ethernet, product description 4
Execution Disable 103
ExpressCard assembly

removal 94

spare part number 34, 94

ExpressCard slot 16
ExpressCard slot insert,
illustrated 27
extended life battery, spare part
number 31
external media cards, product
description 5
external monitor port
location 17
pin assignments 147
External MultiBay Il power cable
and stand, spare part number
30
External MultiBay I, spare part
number 30

F
f11 recovery 140
fan

removal 81

spare part number 23, 81
spare part numbers 34
feet
illustrated 27
locations 44
spare part number 44
File menu 100
fingerprint reader board, spare part
number 23, 34
fnkey 13
front components 15
function keys 13

G
graphics card
removal 87
spare part numbers 24, 34,
35, 87
graphics, product description 2
grounding equipment and
methods 42

H

hard disk test 102

hard drive
location 18
precautions 39
product description 3
removal 51
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spare part numbers 26, 29,
34, 37, 51
specifications 110
hard drive backup 143
hard drive bay 18
hard drive bracket, removal 53
hard drive cover
illustrated 27
removal 52
hard drive recovery
HDMI port 16
headphone jack
location 17
pin assignments 146
heat sink
removal 83
spare part number
hinge
removal 74
spare part number
74
HP Extended Life Battery, spare
part number 30
HP Fingerprint Sensor 12
HP QuickLook 2 104
HP SpareKey enrollment 101
HP un2400 Mobile Broadband
Module
spare part number 26, 59
HP un2400 Mobile Broadband
Module, spare part number 32

140, 145

23, 83

22, 34, 35,

I
I/O address specifications 116
info button 11
interrupt specifications 115
inverter
removal 49
spare part number 32, 49
J
jacks
audio-in 17
audio-out 17
headphone 17
microphone 17
modem 17
network 16
RJ-11 17
RJ-45 16
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K

keyboard
product description 5
removal 61

spare part numbers 22, 32, 61
keypad keys 13

keys
esc 12
fn 13
function 13
keypad 13

pointing stick 12
Windows applications 13
Windows logo 13

L
LAN Power Save 103
language, changing in Computer
Setup 103

LED board

spare part number 22

spare part numbers 35
left-side components 16
legacy support, USB 98, 103
lights

battery 14,15

caps lock 14

drive 14,15

num lock 14

power 13,15

volume down 14

volume mute 14

volume up 14

wireless 13, 15

M
mass storage devices, spare part
numbers 29
Media Card Reader 16
memory map specifications 118
memory module
product description 3
removal 57
spare part numbers 25, 57
memory module compartment 18
memory module compartment
cover
illustrated 27
removal 55, 57, 59

microphone

illustrated 28

product description 4
microphone jack

location 17

pin assignments 146
model name 1
modem jack

location 17

pin assignments 148
modem module

product description 4

removal 64

spare part number 25, 31, 64
monitor port
location 17

pin assignments 147

N
network jack

location 16

pin assignments 148
num lock light 14

o
operating system, product
description 6
optical drive
location 17
precautions 39
product description 4
removal 47
spare part numbers 25, 29, 47
specifications 111, 112, 113
optical drive bracket
spart part number 29, 35, 47
P
packing guidelines 41
parallel port mode 103
passwords 100
pin assignments
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audio-out jack 146
external monitor port 147
headphone jack 146
microphone jack 146
modem jack 148
monitor port 147
network jack 148
RJ-11 148



RJ-45 jack 148
Universal Serial Bus (USB)

port 149
plastic parts 38
Plastics Kit
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spare part number
pointing device
components 10
illustrated 10
product description 5
pointing device components
pointing stick 10
pointing stick buttons 10
TouchPad 10
TouchPad buttons 10
TouchPad scroll zone 10
pointing stick 10, 12
pointing stick buttons 10, 13
pointing stick, spare part number
32
port options 105
1394 port 105
ExpressCard slot 105
flash media reader 105
parallel port 105
serial port 105
Smart Card slot 105
USB port 105
ports
1394 16
eSATA 16
external monitor 17
HDMI 16
monitor 17
product description 5
Universal Serial Bus (USB)
16, 17
power button 11
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power cord
set requirements 150
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power light 13, 15
power requirements, product
description 6
presentation button 12
processor
product description 1
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removal 86
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product description
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docking support 5
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hard drives 3
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operating system 6
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R
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Independent Disks) devices
103
rear components 17
recovering information 139
recovery partition 140
recovery points 143
removal/replacement
preliminaries 38
procedures 43
restore security defaults 105
restore the factory settings 100
restoring the hard drive 140
right-side components 17
RJ-11 connector cable
illustrated 28

removal 93
RJ-11 jack
location 17

pin assignments 148

RJ-45 jack

location 16

pin assignments 148
RTC battery

removal 55

spare part number
Rubber Kit

spare part numbers 34
run-in test 102

25, 35,55

S
SATA (Serial Advanced
Technology Attachment)
devices 103
AHCI (Advanced Host
Controller Interface) 103
IDE (Integrated Drive
Electronics) 103
scheduling backups 144
Screw Kit
contents 119
spare part number
screw listing 119
Secondary Battery Fast Charge
104
security cable slot 17
Security menu 100
allow reset of HP ProtectTools
security keys 101
always prompt for HP
SpareKey enrollment 101
Automatic DriveLock 101
change password 101
Disk Sanitizer 101
DriveLock 101
fingerprint reader reset 101
HP Sparekey 101
HP Sparekey enrollment 101
password policy 101
set up BIOS Administrator
password 100
System IDs 101
user management 101
security, product description 6
service considerations 38
service tag 19, 43
serviceability, product
description 8
set security level 105

31,34
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setup utility
Diagnostics menu 102
File menu 100
navigating and selecting 99
restoring factory settings 99
Security menu 100
System Configuration menu
103
SIM
removal 46
spare part number 25
smart card reader 16
solid-state drive, spare part
numbers 26, 29, 35, 36, 51
speaker assembly
removal 89
spare part number
speakers 15
specifications
Blu-ray Disc ROM Drive 112
computer 106
display 107, 108, 109
DVD-ROM Drive 113
DVD+RW and CD-RW
SuperMulti DL Combo
Drive 111
hard drive 110
I/O addresses 116
interrupts 115
memory map 118
optical drive 111, 112, 113
system DMA 114
start-up test 102
static-shielding materials 42
switch cover
removal 66
spare part number
system backup 143
system board
removal 90
spare part number 25
spare part numbers 34, 35, 90
System Configuration menu 103
system date and time 100
System Diagnostics menu 102
system DMA 114
system fan 103
system IDs 101
system information 100
system memory map 118

25, 34, 89

22, 34, 66
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system recovery points 143

T
Thermal Material Kit, spare part
numbers 23, 34, 35, 83, 87
thermal material, replacement 84
tools required 38
top components 10
top cover
removal 76
spare part number 23, 76
spare part numbers 34, 35
TouchPad 10
removal 79
spare part numbers 23, 35, 79
TouchPad buttons 10
TouchPad scroll zone 10
transporting guidelines 41
TXT (Intel® Trusted Execution
Technology) 104

U
Unified Extensible Firmware
Interface (UEFI) mode 104
Universal Serial Bus (USB) port
location 16, 17
pin assignments 149
USB legacy support 98, 103
USB/audio board
removal 96
spare part number 25, 96
spare part numbers 34
USB/audio cable, illustrated 28

Vv

vents 16, 18

Virtualization Technology 104
volume down light 14

volume mute button 12
volume mute light 14

volume scroll zone 12
volume up light 14

w

webcam, product description 4

Windows applications key 13

Windows logo key 13

Windows Vista operating system
DVvD 141

Wireless Antenna Kit, spare part
number 34

wireless antennas,
disconnecting 59, 66
wireless button 12
wireless light 13, 15
wireless, product description 4
WLAN antennas, locations 9
WLAN module
removal 65
spare part number
65
spare part numbers 23
workstation guidelines 41
WWAN antennas, locations 9
WWAN module
removal 59
spare part number
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